AV=VA
Product Release Latest Update

This release updates the E3D Design 3.1.9 release and includes the following functional enhancements:

General

Visual Query Sets

Visual Queries can now be grouped into sets to be used for a common purpose, e.g. one for each status value
in a workflow for model elements, or one for each discipline in a design area. This makes it much easier to
swap between different graphical views of the data.

e é:‘ & In Run Visual Queries select a Query Set to make its
e ri ive.
et > a8 Queries active
Work packs queries .
) [ e Run Configure

Visual CQuenes

Total ltems =2

@ Visual Queries are accessible in the Tools panel in any module in E3D Design.

Queries

Coler Query Description

L
» [B Lerg= pipes instalies
Small pipes installed

Instrumentaticn installed

In the Visual Queries Configuration form the Query Sets can be accessed and managed via the Visual Query
Sets tab.

Visual Queries Configuration - O X

Visual Query Se | Visuzl Quenes | View Styles | Type Collections

Query Sets Queries in Set Available Queries
Description - Color Query Description &~ Color Query Description |
£ ||
Work packs queries [ Large pipes installed [3 Woark packs in preparation
» | Piping and Instruments queries Small pipes installed v ‘Werk packs pending design approval
Instrumentation installed Work packs approvedfor design

‘Werk packs approved for constructiol
Volumes for planning

Supports not yet installed

Ref grids for design

Pipe and HVAC Spoocls delivered
Pipe pieces for bending

i ﬂj_nn 4
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Field items delivered
Equipment installed
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PFipes and equipment not ina work pe z
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Total ltems =2 Total kems =3 Total ltems =20
e

Release Note - AVEVA™ E3D Design 3.1.9
Last saved: 14/03/25 © Copyright 2025 AVEVA Solutions Limited Page 8 of 191



AV=VA
Product Release Latest Update

BE L9 o caneaen =«

B0 5&
B[R

Biploren

e = |

[T i ottty
[ P ——— BEKUmE A tens

Laser - Project Switch for Cloud Dataset Density
Laser point cloud data with increased point density can now be utilised within E3D Design Model.

Previously, point set data was simplified to ensure that overall performance of the application remained
consistent for larger datasets. At this release an option to utilise cloud datasets with increased density is
included within the product.

This option is provided as a selectable toggle within the Model environment Project -> Options tab (see View
-> Configuration)

2904 Point Cloud

"bﬂ'

Display maximum point cloud density for PCM projects
— on Connect (may affect performance)

| Reset | | Apply |

@ Applying this change within the Model environment will require a short initialisation period. Interaction with Laser
data that includes the enhanced point set data may be less performant than a dataset that has a pointset with
lesser density.

@ When switching back to the default, lower density dataset the user will be prompted to re-enter the design
environment. This change will not take effect unless the user restarts the product manually.

Restoring point cloud density setting requires E3D to be
/ = . restarted for change to take effed.

o)
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Laser - Switch between intensity and color in points and Bubble View

The user can toggle between intensity and color rendering of Point Cloud datasets via the Colour toggle
button within the Point Cloud group within the View tab.

8% G Display + D Detail @ Mask A% O Display D Detail % Mask
Vary Ya¥y

l Low Density # Highlight l Low Density & Highlight

Bubble Rendering w Contours Bubble Rendering v Contours
- - -'-:,% Colour & Colour - = - v Colour & Colour -

Point Cloud

Point Cloud Terrain

Interfaces — Updated HOOPS exchange version for MultiCAD

MultiCAD import includes an upgraded HOOPS Exchange SDK: version 2024.7.0. This version offers extended
functionality over the previous version 2022 SP2 U2 (aligned to AVEVA E3D Design 3.1.8.1)

Notable updates include support for:

Format Supported Versions

Navisworks® 2012 to 2025

Revit® 2015 to 2025

Creo® - Pro/E Pro/Engineer 19.0 to Creo 11.0

NX™ - Unigraphics UG11 to UG18, UG NX, NX5 to NX12, NX1847 to NX2406
Parasolid® Up to 37.0

| For further information on the latest HOOPS Exchange SDK version (and previous versions) please refer to the
release note https://docs.techsoft3d.com/exchange/latest/release notes/2024.7.0.html
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This release updates the E3D Design 3.1.9 release and includes the following functional enhancements:

Structures

Structures — Use a PML function with the Rules Manager

The Rules Evaluation Engine has been updated so that PML functions can be evaluated to provide the
result of the rule execution. An element reference of the item being evaluated can now be passed to the
PML function evaluation rule as a parameter. When defining the rule result, add <element> as a
parameter, for example:

HTestFixingRulel(<element>)
Additional parameters can be passed to the function as fixed values, i.e.
lTestFixingRule2(<element>,100,300)

(D The function must return a STRING value.

(D Note: The RVALUE element which contains the function must have its purpose set to FUNC to enable this function.
The Rule Manager window automatically sets this purpose if it detects a function has been entered in the Result

column.
Rule Manager x
Rue Set
(t H_“_ Rule Set /J1-\elded-Beam-Beam-Gusset-RLSET - Set Template parameters
Rules
Rule Name RulePupose  RuleDescripion  Rule Attribute  Data Key Description 1 Data Key Description o—

| J1-\Welded-Beam-Beam-Gusset-RLSET/GWID | DESP | Gusset Width Rule Gusset Width ot

| J1-Vielded Beam-Bosm-Gusset-RLSET/WTYG | SPRE |"Weld Type Rule i | Weld Detail (Gusset Piate) | \eld Detail (Attached v __ D

4| J1Welded Beam Beam Gusset RLSET/WTYF | SPRE Weld Type Rule Weld Detail (Atached Flange) i

» @ Ji-Welded-Beam-Beam-Gusset RLSET/EX | ATTH [ Example Funchon Fule | NUMB X

o4

Relerence Component J1_\Welded_Beam_Beam Gu_. |

Logical Expressions = Rule Checker

Level hem1  DataDescription 1 Evaluator1 Valuel Opersior hem2 Data Description 2 Evalustor2 Value2 Result +
a | |

» [ Atached | Atiached Degth | < 300 mm | TexampleRule(<elements) +

[Attached | Attached Depth | >= 300 mm T | T exampleRule2] celements) |

-

-

N

Total ltems =2 q

ATTRIE RPRO ADEP LT 300 mm ) Result VexampleRule1( celements)
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This release updates the E3D Design 3.1.9 release and includes the following functional enhancements:

Cable System Module — Cable Data form updates
Route node information is now available for cables selected within the Cable Data form.

For a single selected cable, the route nodes associated with that cable are displayed in the Route Node List
tab.

@ Cable Data b 4
Select Cables to Route

.Ca bles . Route Inférmatio | Rou‘t'ing Error List

Route Element Route Node Type (Dwning Branch

ICWAY-AREADNZ-POWER_B1-RNODE-GD2 TAKE JCWAY-AREADZ-POWER_B1
JCWAY-AREADZ-POWER_B1-RNODE-007 TAKE ICWAY-AREADZ-POWER_B1
IC\WAY-AREADZ-POWER_B1-RNODE-006 GAP JCWAY-AREADZ-POWER_B1
ICWAY-AREADZ-POWER_B1-RNODE-005 TAKE JCWAY-AREADZ-POWER_B1
JCWAY-AREADZ-POWER_B1-RNODE-004 TAKE IC\WWAY-AREADZ-POWER_B1
JCWAY-AREADZ-POWER_B1-RNODE-002 PENE TCWAY-AREAD2-POWER_B1
JCWAY-AREAD2-POWER_B1-RNODE-003 OFFS JCWAY-AREADZ2-POWER_B1
IC\WAY-AREAD2-POWER_B1-RNODE-001 REPO JCWIAY-AREADZ-POWER_B1
ICWAY-AREADI-POWERD1_B1-RNODE-006 | REPO JCWIRY-AREADZ-POWERD1_B1
JCWAY-AREADNI-POWERDT_BT-RNODE-00 | REPO ICWAY-AREADZ-POWERD1_B1
ICWAY-AREADI-POWERD1_B2-RNODE-004 | REPO JCWAY-AREADI-POWERD1_B2
ICWAY-AREADI-POWERD1_B2-RNODE-003 | TAKE JCWAY-AREADI-POWERD1_B2
JCWAY-AREADI-POWERD1_B2-RNODE-00Z | REPO ICWAY-AREADI-POWERD1_B2
JCWAY-AREADI-POWERDT_B2-RNODE-001 | REPO JCWAY-AREADI-POWERD1_B2
JCWAY-AREADT-POWERD1_B1-RNODE-004 | REPO JCWAY-AREADT-POWERD1_B1
IC\WAY-AREAD1-POWERD1_B1-RNODE-003 | REPO ICWAY-AREADT-FOWERD1_B1
ICWAY-AREADT-POWERD1_B1-RNODE-002 | REPO JCWIAY-AREADT-POWERD1_B1
JCWAY-AREADT-POWERDT_B2-RNODE-001 | REPO JCWAY-AREADT-POWERD1_B2
IC\WiAY-AREADT-POWERD1_B2-RNODE-002 | REPO ICWAY-AREAD-POWERD1_B2
Total ltems = 1%
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@ Cable Data

Select Cables to Route

AV=VA

Product Release Latest Update

-C.ables | Route Infermation | Reoute Nede List . Routing Error List.

X

Further options are available by using
the right mouse button on Route
Elements. For example, a list of cables
associated with a route node can be
generated. This can be useful for

Foute Element Route Node Type Owning Branch
JCWAY-AREADZ-POWER_B1-RNODE-008 TAKE JOWAY-AREADZ-POWER_B1
JCOWAY-AREADZ-POWER_B1-RNODE-0O7 TAKE JCWAY-AREADZ-POWER_B1
JCWAY-AREAD2-POWER_B1-RNODE-006 | GAP ICWAY-AREADZ-POWER_B1
JCWAY-AREAD2-POWER_B1-RNODE-005 | TAKE ICWAY-AREADZ-POWER_B1

TCIRY AREADS-POWER. B e Ans
| ICiAY-AREADZ-POWER_B1-
[ ICvIAY-AREAD2-POWER_BT-
[ JCWAY-AREADZ-POWER_PT-

List of Associated Cables...
Print Preview...

Export to Excel...

e n T ANR-POWER_B1

ZADZ-POWER_B1

ZAD2-POWER_B1

=AD2-POWER_B1

JCWAY-AREAD3-POWERD1_B1-RNODE-006 | REPO ICWAY-AREADZ-POWERD1_B1
JCWAY-AREADZ-POWERD1_B1-RNODE-005 | REPO JCWAY-AREADS-POWERDT_B1
JCWAY-AREAD3-POWERD1_B2-RNODE-004 | REPO JCWAY-AREAD3-POWERDT_B2
ICWAY-AREAD3-POWERD1_B2-RNODE-003 | TAKE ICWAY-AREAD3-POWERDT_B2
JOWAY-AREAD3-POWERD1T_B2-RNODE-002 | REFO JCWAY-AREADI-POWERDT_B2
ICWAY-AREAD3-POWERD1_B2-RNODE-001 | REFO JCWAY-AREAD3-POWERD1_B2
JCWAY-AREADT-POWERD1_B1-RNODE-0D4 | REPO JCWAY-AREADT-POWERDT_B1
JCWAY-AREADT-POWERD1_B1-RNODE-003 | REFO JCWAY-AREADT-POWERDT_B1
ICWAY-AREADT-POWERD1_B3-RNODE-001 | REPO ICWAY-AREADT-POWERD1_B3
JCWAY-AREADT-POWERD1_B3-RNODE-D0Z | REPO JCWAY-AREADT-POWERDT_B3

Total ltems = 18
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g List of Cables

CE

All Cables| PassingCables | Incoming Cables | Outacing Cables | Cables ArrivinglLeaving | Cables Fill level |

CWAY-AREAD2-POWER_B1-RNODE-004

%)

determining  which

through a particular node type such

cables

as a penetration or gap.

Cable * Class Type Start Ref End Ref Specification Status Total Length
41| CBLP-BO2-AHU-001 FOWER | BO2-HC-001-T-3 | EQUI-B02-AHU-02-001/POWER | 5-DIN.MGCG-4X25| Cable Routed and Laid | 27423.95mm
41| CELP-BO2-AHU-002 FOWER | BO2-HC-001-T-2 | EQUI-B02-AHU-02-002/POWER | S-DIN.MGCG-4%25| Cable Routed and Laid | 33262.65mm
41| CELP-B0Z2-AHU-003 POWER | BO2-HC-001-T-1 EQUI-B02-AHU-02-003/POWER | 5-DIN.MGCG-2X25 | Cable Routed and Laid | 31396.33mm
4| CELP-DIST-LEVELO3 POWER | DST-220/POWERS | DST-223-T1 5-DIN.MGCG-4X25 | Cable Routed and Laid | 35990.58mm
4| CBLP-JBEP-10104 POWER | MCC-1H JBEP-1010/POWER2 S5-DIN.MGCG-4X25 | Cable Routed and Laid | 59302 25mm
4| CELP-JBEP-1010B POWER | MCC-24 JBEP-1010/POWER1 S-DIN.MGCG-4X25 | Cable Routed and Laid | 60131.2mm
41| CBLP-JBEP-1011A POWER | MCC-2G JBEP-1011/POWER1 S-DIN.MGCG-4X25 | Cable Routed and Laid | 53653.28mm
41| CBLP-JBEP-1011B POWER | MCC-1F JBEP-1011/POWER2 S-DIN.MGCG-4X25 | Cable Routed and Laid | 55213.06mm
41| CBLP-LT-103-B2 POWER | DST-222-T6 LT-103-B2-POWER S-YM.CJV30-3¢¥4 | Cable Routed and Laid | 33180.83mm
41| CBLP-LT-103-B2 POWER | DST-222-T5 LT-103-B3-POWER S-YM.CJV0-3¥4 | Cable Routed and Laid | 30244 34mm
4| CBLP-ST-001-7 POWER | MCC-1C ST-001/POWER1 S-DIN.MGCG-4%25 | Cable Routed and Laid | 37133.11mm
41| CBLP-ST-001-8 POWER | MCC-1B ST-001/POWER2 S-DIN.MGCG-4%25 | Cable Routed and Laid | 37623.65mm
41| CBLP-ST-001-9 POWER | MCC-1A ST-001/POWER3 S-DIN.MGCG-4X25 | Cable Routed and Laid | 38124 4mm

p -5 CBLP-ST-003-03SKID1-PUMPA | POWER | MCC-1G ST-003/POWERT S-DIN.MGCG-4%25 | Cable Routed and Laid | 46326.56mm
41| CBLP-ST-003-03SKID1-PUMPE | POWER | MCC-2D ST-003POWER2 S-DIN.MGCG-4X25 | Cable Routed and Laid | 44343.6mm
43| CBLP-ST-003-03SKID2-PUMPA | POWER | MCC-2C ST-003/POWER3 S-DIN.MGCG-4X25 | Cable Routed and Laid | 45353.83mm
41| CBLP-ST-003-035KID2-PUMPE | POWER | MCC-2B ST-003POWER4 S5-DIN.MGCG-4X25| Cable Routed and Laid | 45877.36mm
4| CBLP-ST-005-10 POWER | MCC-1D ST-005/POWER1 S-DIN.MGCG-4X25| Cable Routed and Laid | 48033.7%mm
41| CBLP-ST-005-11 POWER | MCC-1E ST-005/POWER2 S-DIN.MGCG-4X25 | Cable Routed and Laid | 43155.82mm

Total ltlems =18
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Cable — Cable Path Definition and Route Tasks Form updates

The Path Definition and Route Tasks Form has been updated so that the appropriate radius value is utilized
and displayed for Riser route components.

When modifying a route in the form the selected route point will inform the user if it is a Bend or Riser, and
whether it is using the Inside or Outside Radius value. The Inside Radius is used unless it is an Inside Riser, in
which case the Outside Radius is required.

@ The ability to modify the radius is only available for variable radius catalogue items, fixed catalogue items cannot

be modified
z Copy Next
=
T
&
=  Riser Outside Radius : 750mm
x

Select Route Point...

POINTR 1of RPATH 1of CWBRAN 1of CWAY /CWAY-FI|
POINTR 2 of RPATH 1of CWBRAN 1 of CWAY /CWAY-FIX|
POINTR 3 of RPATH 1 of CWBRAN 1 of CWAY /CWAY-FIX
POINTR 4 of RPATH 1 of CWBRAN 1 of CWAY /CWAY-FIX

Mode
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